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READ ME FIRST 
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Who this document is for..... Excel 2007 level 3 Making the most of Excel is designed for users who 
are confident users of Excel who would like to find out about some of the 
advanced more facilities 

What you need to know 
before working through this 
document... 

Before working through this document you should be confident with 
using a variety of basic functions (including conditional functions such as 
IF), range names, conditional formatting and filtering. 

Aims.... You should acquire skills and knowledge to be able to use the software 
at an efficient level. 

Objectives… At the completion of Excel 2007 level 3 Making the most of Excel you 
should be able to:  

• create and use labels and names in a workbook 

• use a range of logical functions 

• use some of Excel's maths and statistical functions 

• use a range of lookup and reference functions 

• use data validating to control the values that go into a 
spreadsheet 

• summarise and present information in a PivotTable report 

Files needed for this 
document... 

This document and all its associated practice files are available on the 
web.  To find these go to www.bristol.ac.uk/is/learning/resources and in 
the Keyword box type the document code given in the bottom right 
corner of the cover page. 

  

 

http://www.bristol.ac.uk/is/learning/resources
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WORKING WITH TOPIC SHEETS 

 

 

 

 

 

 

 

 

 

The majority of this book comprises single-page 
topic sheets. There are two types of topic sheets: 
task and reference. The layout of both is similar 
– an overview at the top, detail in the centre and 

additional reference (optional) material at the 
bottom. Task sheets contain a Try This Yourself 
step-by-step exercise panel in the detail area as 
shown below. 

 Topic name 

 General topic overview provides an introduction to the topic 

 Try This Yourself (Task-based topic sheets) is a detailed step-by-step practice 
exercise for you to work through. In Reference topic sheets this is usually replaced 
by a box with reference information. 

 In Task topic sheets screen shots and graphics provide a visual clue as to what 
will happen when you work through the Try This Yourself practice exercise. In 
Reference topic sheets the screen shots and graphics are used to visually 
represent information and concepts. 

 The For Your Reference (optional) element provides a quick summary of the steps 
required to perform a task. These usually only appear in Task-based topic sheets. 

 The Handy To Know (optional) element provides additional information such as 
alternate ways of accomplishing a task or further information providing handy tips.  
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CHAPTER 1 LABELS AND NAMES 
 

 

 

 

 

 

 

 

In this session you will: 
• learn about the problems which may be caused by relative 

formulas 

• learn how to use range names. 

Labels and names are used to identify cells and ranges using a tag 
that is more meaningful than ordinary cell references such as B6 or 
C5:D11. These names and labels can be used in formulas and in 
links between worksheets and workbooks to make the formulas 
easier to understand. They can also be used to identify specific print 
areas or to help you to locate a specific place in a spreadsheet. 

If you haven’t worked on your workbook for a while, or have to work 
with someone else’s, the clever use of labels and names will help 
you to find your way around the workbook and to understand the 
formulas. 

 FOCUS 
In 

UoB_ARPE_E775 
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PROBLEMS WITH RELATIVE FORMULAS 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Copying formulas can present problems when 
the shape of the formula varies from cell to cell. 
This can occur when one or more values in a 
formula must be located in a specific cell, row, 

column – that is, the formula must include an 
absolute cell reference. In this exercise you will 
see some strange values when you copy a formula 
to other cells using the default copying method. 

Try This Yourself: 

O
pe

n 
Fi

le
 Before starting this exercise you 

MUST open the file called 
Formulas.xlsx... 

1 Click on the Euros sheet 

2 Enter the formula shown opposite 
in cell C3  to calculate the value in 
euros of £1.00 

3 Copy the formula to cells C4:C6 
using Autofill. 
Note the unexpected results 

4 Examine the formula in each of the 
cells C3:C6 

 When you create a formula, 
references to cells or cell ranges 
are usually based on their position 
relative to the cell that contains the 
formula.  The formula =B3*C9 
entered in cell C3 means “multiply 
the cell one to the left by the sixth 
cell below”.  When you copy a 
formula that uses relative 
references, Excel automatically 
adjusts the references to refer to 
different cells relative to the new 
position of the formula.  For 
example, when copied to cell C4, 
the formula still says “multiply the 
cell one to the left by the sixth cell 
below”, ie =B4*C10. 

5 Delete the formulas in C3:C6.  We 
will solve this problem on the next 
page 

For Your Reference… 
When you copy a formula that uses relative 
references, Excel automatically adjusts the 
references to refer to different cells relative to the 
new position of the formula.  This causes problems 
if the formula in fact needs to refer to one cell as a 
constant.  Range Names can be used to solve this 
problem. 

Handy to Know… 
• Absolute references can also be used to fix 

cell references.  See the Formula 
Referencing chapter for more information.  
 

 

1 
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USING RANGE NAMES 
 

 

 

 

  

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Range Names are used to refer to individual 
cells or ranges of cells as an alternative to using 
cell references.  We will now use a range name 
to fix part of the cell reference so that it will not 

change when a formula is copied.  We need to 
allow the B3 part of the formula to be relative, but 
to fix the C9 part so that it always multiplies by the 
exchange rate.   

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file Formulas.xlsx... 

1 We will make C9 a named cell 

Click in cell C9  

2 Click in the Name Box and 
type Euro_rate and then press 

 
See the notes opposite  

3 Click on the Name Box drop 
down arrow to see that the 
name is listed.  Click on this 
name and notice that your 
cursor will jump to that cell 

4 To use a range name in a 
formula, in cell C3, enter the 
formula =B3*Euro_rate 
You can do this in 1 of 3 ways: 
1. Type the name 
2. Click the named cell (C9) 

3. Press the  key to show 
the Past Name box and 
double click on the name 
you want to use 

5 Copy the formula to C4:C6 
using Autofill.  The results 
should be correct this time 

6 To delete a name, on the 
Formulas tab, in the Defined 
Names group, click on Name 
Manager.  Click on the name 
you want to remove and click 
on [Delete] 

For Your Reference… 
To create a named cell: 

1. Click on the cell to name 
2. In the Name Box type a name & press  

To  use a named cell in a formula: 
1. Type the name, click in the named cell, or 

press  to list all the names 

Handy to Know… 
• As well as being used to create fixed 

references, names can be used to clarify 
formulae and make them easier to create 
and understand 

2 

Need to Know… 
There are two important rules to follow when 
creating Names: 

1. You can only use letters of the alphabet, 
numbers or the underscore character ( _ ) in 
names. Spaces and other special 
characters such as &, * or % are not 
allowed. 

2. Names must not begin with a number. Use 
a letter or an underscore as the first 
character of your name, for example, 
Yr1996 or _2005. 

 

2 
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RANGE NAMES 
Practice Exercise 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tasks: Completed: 

 Before starting this exercise you MUST have completed all of the 
topics in the chapter Labels And Names… 

 

1 Open the workbook called PE_Formulas.xlsx (it can be found in the 
student files folder) 

c 

2 Practice using names by creating the formulae required on the Tax 
sheet in the above workbook.  Follow the instructions headed If using 
Named cell ranges 

c 

3 Continue with the VAT sheet c 

4 If you have time, follow the instructions on the absolute sheet, which is 
more complicated 

c 

   

   

   
   
   

 

Files required for 
exercise: 

PE_Formulas.xlsx 

Files/work created by 
student: 

 

Exercise Completed: c 
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CHAPTER 2 LOGICAL FUNCTIONS 
 

 

 

 

 

 

 

 

In this session you will: 
• learn how to display text using the IF function 

• learn how to use IF to calculate values. 

Logical functions are used in spreadsheets to test whether a 
situation is true or false. Depending on the result of that test, you 
can then elect to do one thing or another. 

These decisions can be used to display information, perform 
different calculations, or to perform further tests. 

 

 FOCUS 
In 

UoB_AR_E714 
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USING IF TO DISPLAY TEXT 
 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The IF function can be used to display different 
information depending on the outcome of the 
condition test. The resulting text will appear in the 
cell where the formula containing the IF function 

resides. In this example, the IF function is used to 
indicate where figures in a neighbouring column 
meet or exceed a specified target. This makes 
identifying the successful sales people far easier. 
 

Try This Yourself: 

O
pe

n 
Fi

le
 Before starting this exercise 

you MUST open the file E714 
Logical Functions_1.xlsx... 

 We want to work out whether 
someone’s monthly sales 
were above or below target 

1 Create the following range 
names: 

• E2 name target 

• E3 name commission 

• C7:C15 name this whole 
range of cells, sales 

2 Click on D7 and then open the 
Insert Function box by 

clicking on .  Then, search 
for the IF function. 

3 Complete the three boxes as 
shown.   

4 Click [OK] to finish, then use 
Autofill to copy the formula 
from D7 to D15 

 Notice that the result for Jerry 
Hancock is Below Target even 
though she achieved 34,000? 
Let’s modify the formula... 

6 Click on D7, then click in the 
Formula bar immediately to 
the right of > and type = then 
press  

7 Use Autofill to copy the new 
formula to the rest of the 
column 

For Your Reference… 
IF(logical test, value_if_true, value_if_false) 
This function performs the test, then if the result is 
true, uses the entry in the position true. If the result 
is not true, the entry for false is used. 

Handy to Know… 
• If you only want text to appear if the result is 

true, you can enter "" (two double quotes) in 
the position for false. For example, 
=IF(C7>=Target, "Exceeded Target","") will 
only display text if the target was met or 
exceeded. 

3 

4 
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USING IF TO CALCULATE VALUES 
 

 

 

 

 

 

 

  

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous 

file with this exercise 

 

1 Click in cell E7 and then open 
the Insert Function box and 
search for the IF function 

2 Complete the different sections 
as shown opposite 

3 Click [OK] to finish the formula 

4 Click on E7 and double-click 
on the fill handle to copy the 
formula down to E15 

Due to the formatting of the 
Commission column, instead 
of a 0, the dash symbol 
appears where no commission 
is to be paid 

5 For further practice, open the 
file IFS.xls and look at the 
different sheets, starting from 
the IF MOT sheet.  Some of 
the sheets have already been 
completed for you, so you can 
study how they work, then 
delete the formulas and create 
them again.  Some use named 
cells, so you’ll need to check 
which cells have been named 

 

One of the most common uses of the IF function 
is to perform numerical computations based on 
the outcome of the condition test. This is 
achieved by putting formulas that would normally 

be used to calculate values in place of the true and 
false components in the function. You can also use 
this structure to show a specific value according to 
the result of the condition test. 

For Your Reference… 
IF(test, true-calculation, false-calculation) 
• This function performs the test, then if the 
result is true, performs the calculation in the 
position true. If the result is not true, the entry for 
false is used. 

Handy to Know… 
• You could have used absolute references 

rather than range names for cells which are 
constants 

2 

4 
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CHAPTER 3 MATHS & STATISTICAL FUNCTIONS 
 

 

 

 

 

 

 

 

In this session you will: 
• learn how to use the SUMIF function 

• learn how to count conditionally 

• learn how to use the SUMIFS function. 

The maths group of functions is one of the largest and most diverse 
group of functions in Excel, with functions ranging from simple SUM 
to complex and specialised functions. 

 

Excel also contains a large number of statistical functions.  These 
can be used to perform relatively simple operations such as 
summing, averaging and finding minimum and maximum numbers, 
as well as calculating standard deviation, variance etc. 

 

Only a few functions are covered here.  Have a look at the Insert 
Function dialog box for a full list.  

 FOCUS 
In 

UoB_AR_EU701 
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USING SUMIF 
 The SUMIF function can be used to add the 

contents of cells specified by particular criteria. 
For instance, in an alphabetical listing of all the 
children in a school, you could use the SUMIF 

function to add the total raised by each class in a 
recent fundraising event. The criteria in this case is 
the class name and the cells to sum would be the 
amount raised by each child in that class. 

Try This Yourself: 

O
pe

n 
Fi

le
 Before starting this exercise 

you MUST open the file E716 
Maths Functions_11.xlsx... 

1 Click on the Sum worksheet 
tab to make this the active 
worksheet 

2 Click on H2 and from the 
Insert Function button search 
for the SUMIF function.    

3 Set up the function as shown 
opposite  

In this example, the Range is 
the Type column, the Criteria 
is the contents in cell G2 and 
the Sum_range is the Annual 
Fee... 

4 Click OK to finish. 

The total Annual Fee for Gold 
is £32,639.50. What about 
Silver? 

5 Click on G2 and type Silver 
then press  

As the text in cell G2 is used 
as the criteria in the function, 
the value is automatically 
updated 

 

For Your Reference… 
SUMIF(range,criteria,sum_range) 
This function adds the contents of cells in the 
sum_range that satisfy the criteria specified in 
range. Sum_range is only required if the range to 
sum differs from the range to be searched. The 
criteria can take the form of a number, text, or an 
expression. 

Handy to Know… 
• Using the SUMIF function, if you wanted to 

add all of the Annual Fees in the range 
H9:H72 that were greater than 55, your 
formula would read =SUMIF(H9:H72,">55"). 
You would not require a sum_range 
argument in this situation. 

4 

3 

5 
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USING COUNTIF 
 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For Your Reference… 
SUMIF(range,criteria,sum_range) 
This function adds the contents of cells in the 
sum_range that satisfy the criteria specified in 
range. Sum_range is only required if the range to 
sum differs from the range to be searched. The 
criteria can take the form of a number, text, or an 
expression. 

Handy to Know… 
• Using the SUMIF function, if you wanted to 

add all of the Annual Fees in the range 
H9:H72 that were greater than 55, your 
formula would read =SUMIF(H9:H72,">55"). 
You would not require a sum_range 
argument in this situation. 

You might need to count cells that contain a 
specific value or conform to specific guidelines. 
For instance, you may wish to know how many 
cells have a value greater than 10, or hold a 

particular label. This type of counting can be 
achieved with the COUNTIF function. This function 
requires two arguments: a range and a value, text 
or condition to base the search on. 

Try This Yourself: 

O
pe

n 
Fi

le
 Before starting this exercise 

you MUST open the file E717 
Stat Functions_4.xlsx... 

1 Click in cell E13 and from the 
Insert Function button search 
for the COUNTIF function. 

In this example we will count 
only the Tuesdays where the 
takings exceeded $30,000... 

2 Set up the Range as B5:N5 
and the Criteria as “>30000” 

3 Click OK to complete the 
formula 

The number of days is 3... 

4 Copy the formula down for 
the other days 

5 For further practice, open the 
Functions_1.xlsx workbook 
and look at the Trees2 sheet. 
NOTE You’ll need a mixture 
of SUMIF and COUNTIF to 
complete these exercises 

6 What is the total area of 
larch? 

7 Work out how many 
plantations have larch trees 

8 Click on the Property sheet 
and calculate the total value 
and total number of houses 
on the list 

 

2 

4 

For Your Reference… 
COUNTIF(range, criteria) 
This function counts the number of cells in the 
range that satisfy the criteria. The criteria can take 
the form of a number, text or an expression. For 
example, the criteria could be 100, “100”, “Gold” or 
“>100”. 

Handy to Know… 
• SUMIF and COUNTIF only allow one criteria 

for comparison.  To use 2 you can use the 
SUMIFS or COUNTIFS functions.  Or for 
more than 2 criteria, use the DSUM or 
DCOUNT function.  See Excel’s Help system 
or look at the Bristol University document 
Advanced Filtering, code exl07all-10. 
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USING SUMIFS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

  

 

The SUMIFS function is used to add the contents 
of cells in a range when multiple criteria are 
met. For instance, in a datasheet listing sales 
figures for different products in different regions, 

you are able to use the SUMIFS function to add all 
the sales figures for a particular product in a 
specified region. In this way you could create a 
summary of each product by region. 

Try This Yourself: 

O
pe

n 
Fi

le
 Before starting this exercise 

you MUST open the file E716 
Maths Functions_12.xlsx... 

1 Ensure that the Sum 
worksheet is currently active 

2 Click on N6 then click on the 
Insert Function icon and 
search for the SUMIFS 
function. 
The structure of this function 
is 
SUMIFS(sum_range,criteria
_range1,criteria1, 
[criteria_range2,criteria2],..
.) 
In this example we want to 
know the Annual Fees for the 
Gold membership renewals 
due in January...  

3 Fill in the Function 
Arguments as shown 
opposite, where: 

Sum_range = I9:I110 

Criteria_range1 = J9:J110 

Criteria1 = N5 

Criteria_range2 = H9:H110 

Criteria2 = M6 

Click [OK] to finish 

4 Repeat the process to 
calculate the totals shown 
opposite 

 

For Your Reference… 
SUMIFS(sum_range,criteria_range1,criteria1, 
[criteria_range2,criteria2],...) 
This function adds the contents of cells in 
sum_range that satisfy the criteria in 
criteria_range1, criteria_range2 etc. 

Handy to Know… 
• If at all practical, it is advisable to run a quick 

manual calculation to ensure that the 
arguments in your functions are recorded 
correctly. 

• The SUMIFS function effectively replaces the 
SUMPRODUCT function in earlier versions 
of Excel. 

3 

3 

4 
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CHAPTER 4 LOOKUP FUNCTIONS 
 

 

 

 

 

 

 

 

In this session you will: 
• gain an understanding of data lookup functions 

• learn how to use VLOOKUP 

• learn how to use VLOOKUP for exact matches 

• learn how to use HLOOKUP. 

Excel provides a number of functions that allow you to look up and 
extract data from a list or table. These are known as Lookup 
functions and they can be used for a variety of purposes. 

 FOCUS 
In 

UoB_AR_E715 
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UNDERSTANDING DATA LOOKUP FUNCTIONS 

 

 

 

 

 

 

 

Data lookup functions are used to retrieve data 
from a table. They generally require at least two 
pieces of information; what to look for and where 
to look for it. The what to look for part is often 

part of table of information which can be referred to 
as a calculation area. The where to look for it is 
known as a data table – a table in which a list of 
rates, figures, text or other items are held. 

Data Area 
The data area is often on a worksheet by itself, protecting it from accidentally being modified or 
deleted. It holds all of the possible values for the data. The values are laid out in a table format, and 
they are listed in numerical or alphabetical order of the code that the lookup function will search for. 

In this example, we have created the name Pay_Rates for the range B3:C7 that holds the data. The 
resulting formula in the calculation area will be easier to understand.  

 

Calculation Area 
The calculation area is usually on a worksheet by itself unless you require the data values to be 
visible as well as the resulting calculations. 

The calculation area uses a formula, such as VLOOKUP, to find the correct data for each situation. 
In this example, the VLOOKUP function shown is comparing the value in C5 with the values in the 
range Pay_Rates. It then returns the value in the second column of the data table, determined by 
the 2 in the formula. 
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USING VLOOKUP 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The classic lookup function is VLOOKUP – the 
vertical lookup. This function searches vertically 
down a sorted data table looking for a match with 
the lookup-value (or the next lowest value).  

It then looks across the table to the column you 
have specified to find the value to return. This is 
ideal for looking up numeric values within a range, 
such as tax rates, or commission amounts. 

Try This Yourself: 

O
pe

n 
Fi

le
 Before starting this exercise you 

MUST open the file E715 Lookup 
Functions_2.xlsx... 

1 Click on the drop arrow  for the 
Name Box and click on Tax_Table 

This is the data table for our 
VLOOKUP.  See the Note opposite.  
Notice also that someone earning 
less than 500 does not pay any tax… 

2 The structure of the function is 
=VLOOKUP(lookup_value,table, 
col_index_num) 

Or, to put it another way: 
=VLOOKUP(what to look up, 
where to look it up, which column 
is the information in?) 

3 Click on the Payroll sheet tab and 
click in G5.  From the Insert 
Function box, search for VLOOKUP, 
set up the function as shown then 
click OK. 
This means we are looking up the 
gross pay value in the Tax_Table 
and it will return the value from the 
second column in the table 

4 0% appears because the gross pay 
is less than $500… 

5 Copy the formula in G5 to the range 
G6:G13 

6 Change Michelle Calahan’s hours 
worked to 30, and notice that she is 
now due to pay 10% tax 

 

For Your Reference… 
VLOOKUP(Lookup_value,Table,Col_index_num) 
This function searches down the left-most column 
of the data table until it finds the lookup-value or 
the row with the next lowest value. It then refers to 
the column index number nominated in the 
function, and returns the value found in the 
corresponding row and column. 

Handy to Know… 
• An alternative to the VLOOKUP function is 

the horizontal or HLOOKUP function. This 
looks for a value in the top row of a table or 
array of values, and returns the value from 
the same column in the row you specify. 

1 

4 

3 

Note: The range of cells 
that make up the data 
table need to either be 
named or fixed in the 
VLOOKUP formula using 
Absolute References.  
Otherwise, when you copy 
a formula down a column, 
the data table will change. 

Also, it’s important that it’s 
the leftmost column of 
this table that contains the 
data to look through. 
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USING VLOOKUP FOR EXACT MATCHES 
 

 

 

 

 

 

 

 

  

  

 

 

 

 

   

 

 

 

 

 

 

 

 

 

 

  

Generally, the VLOOKUP function uses three 
arguments: the lookup-value, the table location 
and the column number. This lookup will find a 
row based on a numeric range. However, you 

may only want to return a value if you get an exact 
match, and the optional fourth argument, match-
type, makes this possible. By adding FALSE to the 
function, #N/A is returned if a match isn’t found. 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file E715 Lookup 
Functions_3.xlsx... 

1 Click on the drop arrow  for 
Name Box and click on 
Items_List 

This lookup table includes 
specific product codes that 
require an exact match… 

2 Click on the Invoice sheet, 
then click in B11 and add the 
item TEL00004. Put 3 in D11 

3 We’ll now look up the price of 
these items.  Click in cell E7 
and set up the VLOOKUP 
function as shown, then click 
OK to finish 
Adding ‘FALSE’ to the 
Range_lookup forces Excel to 
find an exact match in the 
lookup table. If it doesn’t find 
one, it returns the error #N/A 

4 Copy this formula to cells 
E8:E11 

 Notice that in E11, #N/A is 
displayed. This is because 
item number TEL0004 isn’t a 
real Item code, and returning 
the price of the previous item 
in the list isn’t appropriate 

5 Use VLOOKUP to fill in the 
Description and Deposit 

 

For Your Reference… 
To use VLOOKUP for exact matching: 

VLOOKUP(Lookup_value,Table_array,Col_ 
index_num,Range_lookup) 
Use the value of FALSE for range_lookup when 
you want to ensure exact matches only. #N/A will 
be returned if an exact match isn’t found. 

Handy to Know… 
• You can use the ISNA function to trap #N/A 

results. For example, the structure 
=IF(ISNA(lookup),“Code not found”,lookup) 
will display a useful message when an exact 
match is not possible, rather than #N/A 
which does not explain the problem clearly. 

2 

3 

5 
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USING HLOOKUP 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Another commonly used lookup function is 
HLOOKUP – the horizontal lookup. This function 
searches horizontally across a sorted data table 
looking for a match with the lookup-value (or the 

next lowest value). It then looks down the table to 
the row you have specified to find the value to 
return. This can be used to search for text, 
numbers, or logical values. 
 

Try This Yourself: 

O
pe

n 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file E715 Lookup 
Functions_4.xlsx... 

1 Click on the Index worksheet 
tab then click in cell D14 and 
examine the formula 

This is an example of the 
VLOOKUP function. This 
scans down the list of options 
looking for the corresponding 
Equipment number. When it 
finds a match, it returns the 
description. 

You can use HLookup in a 
similar way… 

2 Click on the drop arrow  for 
Name Box and click on 
Rate_Type to see the data 
table.  An exact match is 
required here 

3 Click in cell D15 and type 
=HLOOKUP(C15,Rate_Type,
2,FALSE) then press  to 
finish 

4 The name of the Rate Type 
will be returned and 
displayed… 

5 Experiment with different 
values in cells C14 and C15 

You’ll find that the formulas 
return the corresponding 
descriptions 

 

For Your Reference… 
HLOOKUP(lookup_value,table,row_index_num,
range_lookup) 
This function searches the top-most column of a 
table to find the lookup_value (or the next lowest 
value if an exact match isn’t required), then refers 
to the row index number and returns the value 
from the same column and corresponding row. 

Handy to Know… 
• If the lookup_value is smaller than the 

smallest value in the first row of table, 
HLOOKUP will return the #N/A error value. 

• Range_lookup is an optional argument. If 
TRUE or omitted, it will find the closest 
match in the top row. FALSE forces an exact 
match. 

1 

4 
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CHAPTER 5 VALIDATING DATA 
 

 

 

 

 

 

 

 

In this session you will: 
• gain an understanding of how to restrict data entry using 

Data Validation settings 

• learn how to restrict data to a specific number range 

• learn how to test data validation 

• learn how to create input messages 

• learn how to create error alerts 

• learn how to create drop-down data validation lists 

• learn how to identify existing data that doesn't match new 
data validation rules. 

Data validation is all about making workbooks as foolproof and as 
user-friendly as possible. The idea is to create workbooks that don’t 
let people make mistakes. 

Data validation is similar to cell formatting in that you apply it to a 
cell. Unlike a format that changes the look of a cell or its contents, 
data validation checks the data being entered into a cell. If the data 
is incorrect, data validation can prevent it from being entered. 

 

 FOCUS 
In 

UoB_AR_E765 
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UNDERSTANDING DATA VALIDATION 
 

 
Data validation is used to define restrictions on 
what data can or can’t be entered in a cell. You 
can set validation to prevent users from entering 
data that is not valid. If you prefer, you can allow 

users to enter invalid data but warn them when 
they try to type it in the cell. You can also provide 
messages to say what input you expect for the cell, 
and instructions to help users correct any errors. 

Data Validation Settings 
Data validation is invaluable when you want to share a 
workbook with others in your organisation, and you want 
the data entered in the workbook to be accurate and 
consistent.  You can enter settings to restrict the type of 
information that a user can enter.  Here are some 
examples: 

• Restrict entry to predefined items in a List. 

• Restrict numbers outside of a specified 
range. 

• Restrict dates outside a certain time frame 
(date or time). 

• Limit the number of text characters 
entered into a cell. 

• Validate data based on formulas or values 
in other cells.    

Access the Data tab. Click on the 
drop-down arrow on the Data 
Validation button to select from the 
available menu list.  Alternatively, click 
on the top section of the Data 
Validation button to instantly access 
the Data Validation dialog box.  

On the Settings tab, use the Allow option to control 
what type of restriction you wish to set.  In the above 

example, the Allow option has been set to Whole 
number and the range of numbers set between 

100 and 199. 

Input Messages 
In addition to the validation settings, you can also choose 
to show an input message when the user selects the cell. 
This type of message appears near the cell. You can move 
this message, if you want to, and it remains until you move 
to another cell or press . 

Error Alerts 
You may want to provide a meaningful error message if a 
user types in the wrong information.  Using an error alert, 
you can choose a warning, stop or information error 
message to appear.  Used with an input message, the 
error alert gives the user instructions as to what they have 
done wrong and what information should be entered 
instead.   

Input messages and error alerts appear only when data is 
typed directly into the cells, not when the data is copied or 
filled into the cells. 
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CREATING A NUMBER RANGE VALIDATION 
 

 

 

 

  

  

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

One of the simplest types of data validation is to 
restrict data to a specific number range. The data 
validation is set so that Excel expects you to type 
a number in the cell, and the number must fall 

between a set minimum and maximum value. Any 
other data, such as text, or a number outside the 
range, is rejected. This is ideal for large volumes of 
data entry, and helps to reduce the risk of error. 
 

Try This Yourself: 

O
pe

n 
Fi

le
 Before starting this exercise 

you MUST open the file E765 
Validation_1.xlsx... 

1 Click in cell A10 where the first 
Staff ID is to appear 

When you create a validation, 
you can apply it to the entire 
range that will be affected or 
just to one cell and then you 
can copy the validation to 
other cells 

2 On the Data tab click the Data 
Validation drop-down arrow 
and then click on the Data 
Validation option 

3 Click on the drop arrow  for 
Allow and click on Whole 
number 

4 Click in Minimum and type 
100 

5 Click in Maximum and type 
199 

6 Click on [OK] 

Nothing appears to have 
happened to the cell, but the 
validation criteria will control 
what you try to type into it 

 

For Your Reference… 
To apply a number range as data validation: 

1. Select the cells to have validation applied 
2. On the Data tab click Data Validation and 

then the Data Validation option 
3. Select a numerical option for Allow and set 

the values, clicking [OK] to complete. 

 

Handy to Know… 
• The Data Validation dialog box can be used 

to limit the data to any value, to whole 
numbers or to decimals. You can also use it 
to set a maximum and minimum length for 
information typed into a cell, irrespective of 
whether it is text, a value or a formula. This 
setting is called text length. 

2 

6 

Note:  If you click the top of the Data 
Validation button, the Data Validation 
dialog box is automatically displayed.  
If you click the drop-down arrow in the 
lower part of the button, a menu of 
Data Validation sub-choices appears. 
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TESTING DATA VALIDATION 
 

 

 

 

  

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

  

 

Any data validation applied to a worksheet should 
be tested thoroughly before it is unleashed on 
any unsuspecting user. You must ensure that it 
not only prevents or dissuades the entry of invalid 

numbers, but that you have allowed for all possible 
situations. You must also ensure that any 
messages that appear explain clearly how to 
correct the error that has been made. 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file E765 
Validation_2.xlsx... 

1 Click on cell A10 

2 Type 1 and press   

Because this number falls 
outside the validation range 
specified for this cell (100 – 
199), a message box will 
appear… 

3 Click on [Retry] 
This will select the contents of 
the cell so that you can type 
another number… 

4 Type 106 and press  

This time the number is within 
the acceptable range, so the 
message does not reappear 

 

For Your Reference… 
To test data validation: 

1. Try entering a range of values within and 
outside the defined range 

2. If an error message appears, click on [Retry] 
or [Cancel] 

Handy to Know… 
• If you type text in a cell that is expecting 

numbers, it will display the same  
non-specific error message. 

2 
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An input message is a message that is 
displayed when you click on a cell. This provides 
clear guidance to the user about the values that 
are expected for a cell. It is far more satisfying 

than being faced with a non-specific error message 
and not knowing how to fix the error. Input 
messages should be used with validation criteria to 
ensure the best possible result. 
 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file E765 
Validation_3.xlsx... 

1 Click on cell A10 

2 On the Data tab, click on the 
top part of the Data Validation 
button to display the dialog box 

3 Click on the Input Message 
tab 

4 Click in Title and type ID 
Codes 

5 Click in Input message and 
type Please enter a value 
between 100 and 199. 

6 Click on [OK] 

Because cell A10 is still 
selected, the message you 
have just typed will be 
displayed  

Click  to hide the input 
message 

 

For Your Reference… 
To create an input message: 

1. Click in the cell(s) where the validation is 
2. On the Data tab, click Data Validation, Data 

Validation to display the dialog box 
3. Click on Input Message and type a Title and 

Message and then click [OK] 

Handy to Know… 
• By removing the tick from the checkbox for 

Show input message when cell is 
selected, you can hide the input message 
without deleting the message text 
permanently. 

2 

6 
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Error alerts enable you to replace the standard 
error message with something more meaningful. 
The message “Please enter a value between 100 
and 199.” indicates that there is an error, and 

clearly explains what is required. Users will find it 
much easier to complete their tasks if they know 
exactly what to do. The three styles of error alerts 
are Stop, Warning and Information. 
 

Try This Yourself: 

O
pe

n 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file E765 
Validation_4.xlsx... 

1 Click on cell A10 

2 On the Data tab, click the Data 
Validation button and then 
click on the Error Alert tab 

3 Click on the drop arrow  for 
Style and click on Information 

Notice that the red Stop 
symbol has been replaced by 
the Information symbol… 

4 Click in Title and type Check 
Staff ID! 

5 Click in Error message and 
type Please try again. Staff 
IDs must be between 100 
and 199.  

6 Click on [OK] 

7 Type 45 and press  

Your customised error 
message will appear… 

8 Click on [OK] 

9 Click in A10, then type 106 
and press  

 

For Your Reference… 
To create an error alert: 

1.  On the Data tab click Data Validation  
2. Click on the Error Alert tab 
3. Select a message Style 
4. Type a Title and Error message 
5. Click on [OK]  

Handy to Know… 
• There are three styles of error alert – Stop, 

Warning and Information – so you can 
select one that suits your message. 

• An alert only works when data is directly 
entered into a cell.  Data that is copied or 
moved from other cells won’t activate the 
message. 

2 
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If you have a limited number of possible options 
for a cell, you can create a drop-down list for the 
user to select from. This ensures that the spelling 
of the choices is consistent, and makes it much 

easier for the user to complete their data entry 
tasks. Lists are created using the Data Validation 
settings and a separate list of items is stored in the 
workbook.  
 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file E765 
Validation_5.xlsx... 

1 
Click on the Sources 
worksheet tab and look at the 
lists.  Select cells A3:A7 and 
notice that this range of cells 
has been named Titles (look 
in the Name Box when the 
cells are selected). 

We’ll use the Titles list as the 
entries for the drop-down list… 

2 Click on the Payroll tab, then 
click on cell B10 

3 On the Data tab, click on the 
Data Validation button and 
then click the Settings tab 

4 Click on the drop arrow  for 
Allow and click on List 

5 Click in Source and press  
to display a list of range names 

6 Click on Titles to select it, then 
click on [OK] 

7 Click on [OK] to apply the 
settings 

Because cell B10 is already 
selected, a drop arrow will 
appear… 

8 Click on the drop arrow  for 
B10 to display a list of titles 

9 Click on Mr to select it and 
enter the text in the cell 

For Your Reference… 
To create a drop-down list: 

1. Type a list of items in a worksheet, then click 
where you want the list to appear 

2. On the Data tab, click on the Data 
Validation to and then click the Settings tab 

3. Select List in Allow, type the list range for 
Source, then click on [OK] 

Handy to Know… 
• The list we used has been given a range 

name (Titles) to make it easier to locate. It 
has also been placed on a separate 
worksheet to protect it. To provide even 
better protection, you could hide the 
worksheet by right clicking on the worksheet 
tab and selecting Hide. 

1 

6 

8 
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You can apply data validation to cells that already 
have data entered in them. However, Excel does 
not automatically inform you that the existing 
cells contain invalid data. In these instances, you 

can highlight invalid data by instructing Excel to 
circle it on the worksheet.  Once you have 
identified the invalid data, you can hide the circles 
again.  

Try This Yourself: 

O
pe

n 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file E765 
Validation_7.xlsx... 

1 Click on the HR worksheet tab 
to display its data 

2 Select B9:B30 which contains 
existing Staff IDs and blanks 

3 On the Data tab, click the top 
section of the Data Validation 
button  

We’ll now create a validation 
setting so that only IDs 
between 100 and 199 are valid  

4 Complete the Settings tab as 
shown in the example and 
then click [OK] 

5 Click in B21 and type 300 and 
press  
An error message will appear 
because you’ve entered a 
number outside of the 
validation range.  Click [Retry] 
and then enter 100 

6 Now on the Data tab, click on 
the lower part of the Data 
Validation button and select 
Circle Invalid Data  

7 Notice that some of the data in 
the Staff ID column that was 
entered before the validation 
rule was set is now circled 
because it doesn’t match the 
validation settings 

 

For Your Reference… 
To circle invalid data: 

1. Now on the Data tab, click on the lower part 
of the Data Validation button 

2. Select Circle Invalid Data 

Handy to Know… 
• To find cells which have data validation, on 

the Home tab, in the Editing group, click 
Find & Select, and then Data Validation. 
You can then change, remove or copy 
validation settings. 

• To remove invalid data circles, on the Data 
tab, click the bottom of the Data Validation 
button and select Clear Validation Circles. 

4 
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CHAPTER 6 PIVOTTABLES 
 

 

 

 

 

 

 

 

In this session you will: 
• gain an understanding of how and when to use PivotTables 

• gain an overview of how to work with the PivotTable Field 
List 

• learn how to create a PivotTable report 

• learn how to add fields to a PivotTable report 

• learn how to change field settings in a PivotTable report 

• learn how to apply a filter to a PivotTable report 

• learn how to refresh the information in a PivotTable 

• learn how to add new data to a PivotTable 

• learn how to create a PivotChart report 

• learn how to change the layout of a PivotTable report 

• learn how to expand and collapse the detail levels in a 
PivotTable report. 

PivotTable reports are a quick and easy way to summarise, 
analyse, investigate and present data.  They are particularly useful 
if you are working with large amounts of list data. 

 FOCUS 
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UNDERSTANDING PIVOTTABLES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

PivotTable reports are an interactive way to 
quickly summarise large amounts of data. You 
can use them to analyse numerical data in detail 
and to answer unanticipated questions about 

your data.  Using the unique PivotTable Field List 
you can literally manipulate your data at the click of 
the mouse button. 

When to Create a PivotTable Report 
Create a PivotTable report when you want to: 

• Query large amounts of data quickly and easily.  

• Subtotal and aggregate numeric data, summarising data by categories and subcategories, and 
creating custom calculations and formulas.  

• Expand and collapse levels of data to focus on your results, drilling down to the details from the 
summary data for areas that most interest you.  

• Move rows to columns or columns to rows (or "pivoting") to see different summaries of the 
source data.  

• Filter, sort, group, and conditionally format subsets of data to enable you to focus on the 
information that you want.  

• Present accurate, summary, online or printed reports. 

The PivotTable report reflects the 
choices that you make in the 
PivotTable Field List pane.  In 
this example, the data is 
summarised by Department 
calculating the total Annual 
Fees. 

Use the PivotTable Field 
List to add fields to the 
areas section at the 
bottom of the list.  You 
can include fields by 
clicking in their check box 
or by dragging them to a 
particular box in the 
areas section. 

In this section, you can 
move fields from one box 
to another.  You can also 
click on a field to display 
a menu of choices.  
Some of these choices 
are to move the field to 
other locations, to move 
its position within the 
current box (if there are 
multiple fields in a box), 
to change its field 
settings, etc. 

If you’re working with very large 
amounts of data, you might want 
to check the Defer Layout 
Update option so that the 
PivotTable only updates 
when you click the [Update] 
button. 

Use this button to change 
the layout of the 
PivotTable Field List 
pane.  For example, if you 
are working with lots of field 
names, you might like to 
Fields Section only when 
you make your field 
choices. 
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It's important to understand how the PivotTable 
Field List works and the ways in which you can 
arrange different types of fields.  This will help to 
ensure that you achieve the best results that you 

want when you lay out a PivotTable report. 

Adding Fields 
To add fields to the report, do one or more of the following:  

• Select the check box next to each field name in the 
PivotTable Field List section. The field is placed in a default 
area of the layout section, but you can rearrange the fields if 
you want.  

• By default, non-numeric fields are added to the Row Labels 
area, numeric fields are added to the Values area, and OLAP 
(Online Analytical Data Processing data) date and time 
hierarchies are added to the Column Labels area.  

• Right-click the field name (as shown in the example) and then 
select the appropriate command, Add to Report Filter, Add to 
Column Label, Add to Row Label, and Add to Values, to place 
the field in a specific area of the layout section. 

Rearranging Fields 
You can rearrange existing fields or reposition those fields by using one of 
the four areas at the bottom of the layout section:  

• Values – used to display summary numeric data. 

• Row Labels - used to display fields as rows on the side of the 
report. A row lower in position is nested within another row 
immediately above it. 

• Column Labels - used to display fields as columns at the top of the 
report. A column lower in position is nested within another column 
immediately above it. 

• Report Filter - used to filter the entire report based on the selected 
item in the report filter. 

Manipulating Individual Fields 
You can click on any field in the layout section and use the shortcut 
menu to manipulate the field to another one of the four boxes, or to 
another position within its current box. You can also use this shortcut 
menu to delete a field from the layout section. 

By default, each time that you make a change in the PivotTable Field 
List, the report layout is automatically updated. To improve 

performance when you are accessing a large amount of external data, 
you can switch to manual updating. When you switch to manual 

updating, you cannot use the report until you switch back to automatic 
updating. However, you can quickly add, move, and remove fields from 

the field section to the layout section, and then switch back to 
automatic updating to see your results. Use the Defer Layout Update 

to switch to manual updating. 
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The first step when creating a PivotTable is to 
identify the data source and then the location of 
where the PivotTable should be stored.  This can 
be either on the same worksheet as the data or 

on another worksheet.  With this information, Excel 
then creates an empty PivotTable in the specified 
location ready for you to use the PivotTable Field 
List to construct your PivotTable report. 

Try This Yourself: 

O
pe

n 
Fi

le
 Before starting this exercise 

you MUST open the file EK771 
PivotTables_1.xlsx... 

1 Click anywhere in the table 
then click on the Insert tab 

2 Click on the bottom half of 
PivotTable button and choose 
PivotTable to display the 
Create PivotTable dialog box 

3 Check that the range selected 
is $A$6:$I$108 then click on 
[OK] 

A PivotTable report will be 
created in a new sheet ready 
for you to start adding fields. 
The PivotTable Field List will 
appear on the right of the 
screen… 

4 Click on the close button  on 
the PivotTable Field List to 
close it 

5 On the PivotTable Tools: 
Options tab, click on Field 
List in the Show/Hide group 
to redisplay the field list 

6 Click outside of PivotTable 

The field list and other panes 
will be closed… 

7 Click back inside the 
PivotTable to redisplay the 
PivotTable Field List 

 

For Your Reference… 
To create a PivotTable report: 

1. Click within the data that is to be used 
2. Click on the Insert tab and then click on 

[PivotTable] and select PivotTable 
3. Specify your options and click on [OK] 

Handy to Know… 
• Make sure that your data has column 

headings which can be used as field names. 
• It is a good idea to convert your data to a 

table before creating a PivotTable from it. 
Changes to the data in tables including new 
rows are automatically included in the 
PivotTable when it is refreshed. 
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Once you’ve create a PivotTable report, you can 
use the PivotTable Field List to add, rearrange 
and remove fields. By default, the PivotTable 
Field List displays two sections: a field section 

at the top for adding and removing fields, and a 
layout section at the bottom for rearranging and 
repositioning fields including the Report Filter, 
Column Labels, Row Labels and Values. 
 

Try This Yourself: 

O
pe

n 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file EK771 
PivotTables_2.xlsx... 

1 Ensure you are working on 
Sheet 1 

2 In the PivotTable Field List 
check the Type field and then 
the Annual Fee field 

Notice where they are placed 
in the bottom section of the 
panel and how the report now 
appears 

3 Now drag the Type field in the 
Row Labels section across to 
the Column Labels section 

4 Now click on the checkbox for 
the Due field to add it as a 
Row Label 

5 Click on the checkbox for 
Department to add it as a 
Row Label 

The report will now show the 
annual fees for each 
membership type, by month 
and department. You may like 
to right-align the headings 
such as Gold so that they 
appear above the figures that 
they relate to 

6 Click on the arrow next to Due 
and select Move Down and 
notice how the report changes 

7 Now use the arrow on Due to 
move it back up again 

For Your Reference… 
Options for adding fields to a PivotTable report: 

• Drag a field from the PivotTable Field List 
down into an appropriate layout box 

• Click in the checkbox next to the field that 
you wish to add to the layout 

• Right-click on the field and select the layout 
box to place it in 

 

Handy to Know… 
• Once a field has been added to the layout 

you can drag it into another layout box to 
change the structure of the report. 

• You can remove a field from the report by 
dragging it out of the layout area or by 
clicking on the field's checkbox in the 
PivotTable Field List to remove the tick. 

2 

5 



Excel 2007 level 3 - Making the most of Excel 

University of Bristol Page 30 Chapter 6 - PivotTables 

VALUE FIELD SETTINGS 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Each field in a PivotTable report has predefined 
field settings which can be changed to suit your 
report requirements.  For example, by default, 
fields that are added to the Values area are set 

to sum the data thus displaying totals in the 
PivotTable report. You can change the setting so 
that the report displays different statistical results, 
such as average values, maximum values, etc. 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file EK771 
PivotTables_3.xlsx... 

1 Click on Sum of Annual Fee 
in the Values area and select 
Value Field Settings to 
display the Value Field 
Settings dialog box 

2 Click on Count and then click 
on [OK] 

Now the PivotTable report 
shows a count of records 
rather than a sum. You can 
also select averages … 

3 Click on Count of Annual Fee 
in the Values area and select 
Value Field Settings 

4 Click on Average and then 
click on [OK] 

The new figures have too 
many decimal places! 

5 Click on Average of Annual 
Fee in the Values area and 
select Value Field Settings 

6 Click on [Number Format] to 
display the Format Cells 
dialog box 

7 Click on Number and ensure 
Decimal places is set to 2 
then click on [OK] twice to 
update your report 

 

For Your Reference… 
To change the value field settings: 

1. Click on the field you wish to change in the 
Values box in the layout area 

2. Select Value Field Settings 
3. Make a selection from the Value Field 

Settings dialog box and click on [OK] 

Handy to Know… 
• You can further customise how results are 

shown in a report by using the Show values 
as tab in the Value Field Settings box. 

• If you click on a field’s data in the report 
area, you can use the PivotTable Tools: 
Option tab and Field Settings to make 
changes to the field settings options. 
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APPLYING A FILTER TO A PIVOTTABLE 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Filtered data displays only the subset of data that 
meet the criteria that you specify and hides data 
that you do not want displayed. Unlike filtering a 
cell range or table, you do not need to reapply a 

filter. Filters are automatically reapplied every time 
the PivotTable is refreshed or updated.  

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous 

file with this exercise, or open 
the file EK771 
PivotTables_4.xlsx... 

1 Examine the areas below the 
Field List which are Report 
Filter, Row Labels, Columns 
Labels and Values areas 

2 Drag the Department field 
from Row Labels up into the 
Report Filter area 

3 Click on the drop-arrow  for 
the Department field on the 
PivotTable, click on 
Brokerage and click on [OK] 
to display the Brokerage totals 

4 Click on the drop-arrow  for 
the Department field, click the 
checkbox for Select Multiple 
Items and click Accounts, 
Admin, Brokerage,  
Communications and then 
click [OK] 

5 Using the Department field, 
now select (All) to display all 
of the records again 

  

 

For Your Reference… 
To create a report filter: 

1. Add a field to the Report Filter area 
2. Click on a drop-arrow  on the filtered field 

and click on the value that you want the data 
filtered by 

3. Use Select Multiple Items if needed then 
click on [OK] 

Handy to Know… 
• To make the Filter menu wider or longer, 

click and drag the grip handle at the bottom. 
• To display different options on the Filter 

menu click on either Row or Column Labels 
on the PivotTable area.  To filter numerically 
click on Value Filters and choose one of the 
commands. 
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REFRESHING A PIVOTTABLE 
 

 

 

 

  

 

 

 

  

 

 

  

 

 

 

 

 

 

  

 

 

 

  

 

When you alter data on the original spreadsheet, 
these changes will not automatically transfer to 
the PivotTable.  It is necessary to refresh the 
data. 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous file 

with this exercise... 

 

1 Adjust the Values field to show 
the Sum of Annual Fee rather 
than the average. 

Examine the PivotTable and 
notice that £2250 is due from 
Gold members in January 

2 Click on the Data Sheet tab to 
return to the original  data set 

3 Roger Wilson, member 
number 1 is a Gold member 
due to pay in January.  Change 
his membership to Silver and 
press   

4 Notice that his Annual Fee is 
now 750.00 

5 Click back on the Sheet 1 tab to 
return to the PivotTable 

6 Again, look at Annual Fee due 
from Gold members in January 
and notice that it is still £2250  

7 On the PivotTable Tools: 
Options tab, click on Refresh 
in the Data group 

Gold membership fees due in 
January should now be £1125 

 Changes made within the 
original data set (including new 
rows of data) can be updated in 
the PivotTable by clicking the 
Refresh button 

For Your Reference… 
To refresh a PivotTable after amending details 
within the original data set: 

1. Make the change on the original data set 
2. Return to the PivotTable and in the 

PivotTable Tools: Options tab, click 
Refresh 

Handy to Know… 
• If new information is added to the bottom of 

the original data set, this will not be included 
by simply refreshing the spreadsheet.  In this 
case, you will need to extend the data source 
of the PivotTable – see later task. 
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ADDING NEW DATA TO A PIVOTTABLE 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

New data added in the middle of the original data 
source will be included in the PivotTable when it 
is refreshed.  However, data added at the bottom 
of the original data source, will not be added as it 

is outside the original source data range.  In this 
case it is necessary to extend the data source to 
include the new data. 

For Your Reference… 
To include new data inserted at the end of a data 
source in your PivotTable, you need to extend the 
PivotTable data source:  Click on the PivotTable 
Tools: Options tab, choose Change Data Source.  
Then, hold down the  key and click on the last 
cell to be included.  Click [OK] and refresh the 
PivotTable. 

Handy to Know… 
• You can sort data included in a PivotTable  

(eg into alphabetical order) and apply 
formatting 

Try This Yourself: 

Sa
m

e 
Fi

le
 Continue using the previous file with 

this exercise... 

 

1 Click on the Data Sheet tab to go to 
the original data set 

2 Add the new member whose details 
are opposite at the bottom of the data 
set, in row 109 

3 Copy the formula from G108 to G109 
and from  I108 to I109, to work out 
the Annual Fee and Due date 

Notice that Rachel Afan is a Gold 
member whose Annual Fee is due in 
January 

4 Return to the PivotTable on Sheet 1 
and notice that Annual Fee due from 
Gold members in January is £1125.  
Refresh the table.  The figure for 
Gold members annual fee due in 
January will not change,  as Rachel 
Afan was added outside the range of 
the original data set 

5 We need to extend the data source: 
On the PivotTable Tools: Options 
tab, click on Change Data Source 

6 Your data set will be displayed.  
Scroll to the bottom of this and see 
that Rachel Afan is outside the 
selected range 

9 Hold down  and click on cell 
I109 to extend the data source, then 
click [OK].  Refresh your data again 
and check Annual Fee due from Gold 
Members in January is now £2250 

2 Add the new member Rachel Afan: 

No. 103 

First Name: Rachel 

Last Name: Afan 

Joined: 11/1/04 

Department: HR 

Type: Gold 

Spa Member: No 
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CREATING A PIVOTCHART 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A PivotChart can be created from scratch in a 
similar way as a PivotTable report.  Select your 
data and then choose PivotTable, PivotChart on 
the Insert tab. With PivotCharts, you can create 

a single chart and interactively view the data in 
different ways by changing the report layout or 
the detail that is displayed.  You can also create 
a PivotChart from a PivotTable report. 
 

Try This Yourself: 

O
pe

n 
Fi

le
 Before starting this exercise 

you MUST open the file EK771 
PivotTables_7.xlsx... 

1 Click anywhere within the 
PivotTable report to activate 
the PivotTable Tools 

2 Click on the PivotChart button 
in the Options tab 

3 Select the Clustered Cylinder 
chart and then click [OK] 

A chart representing all the 
data will be displayed 

Now let’s change the filter so 
that only the fees payable for 
the Accounts department are 
displayed 

4 Click on the drop-down arrow 
on the Department field in the 
PivotChart Filter Pane 

5 Uncheck Select All and then 
select only Support and click 
[OK] 

6 Now change the filter for the 
Department field so that the 
chart only shows data for the 
Communications group 

7 Save the file, closing it on 
completion 

 There are many more features 
available for PivotTables and 
Charts – try some more for 
yourself... 

 

For Your Reference… 
To create a PivotChart from a PivotTable: 

1. Click in the PivotTable report area 
2. On the PivotTable Tools: Options tab click 

the PivotChart option 
3. Use the PivotChart Filter Pane to specify 

your chart settings 

Handy to Know… 
• A PivotChart report provides a graphical 

representation of the data in a PivotTable 
report. You can change the layout and data 
that are displayed in a PivotChart report just 
as you can in a PivotTable report. 
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(OPTIONAL) CHANGING THE PIVOTTABLE REPORT LAYOUT 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once you have added the fields, displayed the 
appropriate level of details, created calculations, 
filtered and grouped data in your PivotTable 
report, you may also want to enhance the layout 

and format of the report to improve readability and 
to make it more appealing to the reader. 

Try This Yourself: 

O
pe

n 
Fi

le
 Before starting this exercise 

you MUST open the file EK771 
PivotTables_5.xlsx... 

1 On Sheet1, ensure you have 
clicked in the PivotTable area 

2 Take a few moments to look at 
the current PivotTable layout 

3 On the PivotTables Tools: 
Design tab click on Subtotals 
and choose Show All 
Subtotals at Bottom of 
Group 

4 Click on Grand Totals and 
select Off for Rows and 
Columns 

5 Click on Report Layout and 
select Show in Tabular Form 

6 Click on the Blank Rows 
button and select Insert Blank 
Line After Each Item 

7 On the PivotTable Styles box, 
click on the More button and 
select the style called Pivot 
Style Medium 2 

8 Try previewing this worksheet 
to see how it would print if you 
wanted to output to paper  

Click Close Print Preview to 
return to the worksheet on 
completion 

 

For Your Reference… 
To change the layout for a PivotTable report: 

1. Ensure you have clicked within the 
PivotTable area 

2. Click on the Design tab under PivotTable 
Tools 

3. Use the available layout commands 

Handy to Know… 
• If you prefer, you can also click on a field in 

the PivotTable Field List and select Field 
Settings.  On the Layout & Print tab, you 
can specify the individual printing or layout 
characteristics for that particular field. 
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(OPTIONAL) MANIPULATING PIVOTTABLE DETAIL 
 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

  

The PivotTable Tools: Options tab contains a 
selection of different ways that you can 
manipulate and enhance the structure of a 
PivotTable.  For example, you can expand and 

collapse groups, sort data and turn certain 
elements on and off. 

Try This Yourself: 

O
pe

n 
Fi

le
 Before starting this exercise 

you MUST open the file EK771 
PivotTables_6.xlsx... 

1 Using the PivotTable Tools: 
Design tab change the Report 
Layout to Show in Compact 
Form 

2 Use the Grand Totals button 
to turn them on for rows and 
columns 

3 Click on the PivotTable 
Tools: Options tab and click 
the Collapse Entire Field 

button  

4 Expand only the February and 
March data using the Expand 
icon   

5 Now, in the Active Field 
group, click on the Expand 
Entire Field button 

 

6 Click on any Department 
name in column A and then 
click the Sort Descending 
button  

7 On the PivotTable Tools: 
Options tab, try turning off and 
on each of the buttons in the 
Show/Hide group 

 

For Your Reference… 
To expand or collapse all groups on a PivotTable: 

1. Click in the PivotTable 
2. On the PivotTable Tools: Options tab click 

Expand Entire Field or Collapse Entire 
Field 

Handy to Know… 
• You can hide specific items in a row label or 

column label to help you eliminate 
unnecessary information from your 
PivotTable report. Hiding an item in a row 
label or column label removes the item from 
the report, but the item still appears in the 
drop-down list for the label. 

•  
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PIVOTTABLES 
Practice Exercise 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Tasks: Completed: 

 Before starting this exercise you MUST have completed all of the 
topics in the chapter PivotTables… 

 

1 Open the workbook called PE_PivotTables.xlsx (it can be found in the 
student file folder) 

c 

2 Create a PivotTable in a new worksheet that sums Annual Fee in each 
Frequency (row) by Type (column), then add Town as the report filter 
field and select Mansfield 

c 

3 Use the Town field so that that filter shows All towns. Now filter out the 
column for Lawns (remember to use the drop-down arrow to manually 
filter the Column Labels) 

c 

4 Apply a currency format to the figures (no decimals) using the Field 
Settings button 

When deselected, your table should appear similar to that shown in 
sample A on the next page… 

c 

5 Create another PivotTable that shows the number of clients (Code) for 
each Month Due (row) by Type (column)  - right align the data in the 
columns so that the figures line up correctly 

When deselected, your table should appear similar to that shown in 
sample B on the next page (the year shown may change as this field is 
set to update automatically each year)… 

c 

6 Save the workbooks as PE_PivotTables (Completed).xlsx c 

 

Files required for 
exercise: 

PE_PivotTables.xlsx 

Files/work created by 
student: 

PE_PivotTables (Completed).xlsx 

Exercise Completed: c 
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PIVOTTABLES  
Practice Exercise 
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